
Chapter 1  

Getting Started with 
Primavera P6

Learning Objectives
After completing this chapter, you will be able to:
• Understand the basics of project management
• Understand the need of project management
• Understand project planning
• Start Primavera P6
• Understand interface screen of Primavera P6
• Understand workspace
• Set the user and admin preferences
• Create a new project
• Open a project
• Export and Import a project
• Close a project
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INTRODUCTION TO PRIMAVERA P6
Primavera P6 is a high end project management software which provides enterprise-wide solution. 
It helps in reducing costs, delivering the project on the projected time by streamlining and 
coordinating with the management level changes. This software optimizes the overall resources 
so that the project runs efficiently no matter how big the size of the project is. It is designed to 
manage a large number of projects at a time to fulfill the project management requirements in 
an organization. 

By using Primavera P6, one can simultaneously plan major project strategies and control the 
minute details to finish the project. The resources will be used effectively and productively.

In this chapter, you will be introduced to Primavera P6. Also, you will learn to navigate in this 
software and to customize and save screen layouts. With the completion of this chapter, you will 
be able to comfortably navigate through the Oracle Primavera P6 R8.4 and to customize the 
interface to suit your project needs.

BASIC FEATURES OF PRIMAVERA P6
Primavera P6 features a wide range of project management methodologies. These methodologies 
are briefly discussed below.

•  Centralized Project Repository
Primavera P6 offers flexibility for determining who will access a project from all projects in a 
centralized database.

•  Enterprise Project Structure & Codes
Enterprise Project Structure (EPS) helps to create a hierarchical structure for the projects based 
on the requirements of an organization.

•  Cross Project Analysis and Reporting
You can easily and quickly create cross-project dependencies and can determine how projects 
affect one another. You can also determine whether the resources are under or over allocated 
across projects.

•  CPM Scheduling
Primavera P6 provides Critical Path Method (CPM) scheduling using the activities and 
relationships between activities and calendars to maintain a project schedule. It identifies the 
critical activities that affect the completion of the project.

•  Float Path Analysis
Float Path Analysis identifies all the critical paths within a project to avoid potential delays. It 
also helps in visualizing the activity’s importance.

•  Cross Project Dependencies
It helps in monitoring the overall critical path of activities and minimizes the risk of multiple 
parties working together.
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•  Resource Allocation
Primavera P6 tracks labor, material, equipment, and expenses needed for the activities.

•  ERP or Accounting Integration
Primavera allows integration with ERP or accounting system so that the schedule and cost 
information can be shared.

•  Resource Leveling
It helps to ensure that sufficient resources are available to perform the activities in the project plan.

•  Baseline Management
Unlimited versions of the schedules, resources, and costs can be stored to compare how the 
project progresses with reference to the original plan.

•  Project Reports
In Primavera P6, you can generate predefined and customized reports for a project.

CONCEPT AND NEED OF PROJECT MANAGEMENT
In simple terms, project management is the process of achieving set goals within the specified 
time, budget, and other resources. It helps to get maximum out of the available resources 
like manpower, money, materials, facilities, information, and many more. This process helps 
management or teams in an organization to plan, execute, and complete tasks on specific date 
or time and within a limited budget.  
 
Following are three stages or phases of project management:
1. Planning 
2. Controlling
3. Managing

PLANNING PROJECTS
Project planning is a part of project management related to the use of schedules, such as Gantt 
charts, that help to plan and manage projects in the project environment. While planning a 
project, first the scope of the project is defined by the duration of various tasks necessary to 
complete the work. These tasks are listed and grouped in Work Breakdown Structure. The 
duration of tasks is often estimated through an average of optimistic, normal, and pessimistic 
cases. 

Second, the resources necessary for the given project can be estimated and the costs of activities 
can be calculated according to the resources assigned to those activities to get the total project 
cost. The project is then optimized to achieve the balance between the resource usage and project 
duration to comply with the objectives. This phase of project planning is followed by project 
schedule, and project management plan.
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Purpose of Planning
The purpose of project planning is to achieve project objectives and to predict which activities 
and resources are critical for timely completion of the project. Therefore, planning helps in 
making strategies to attain the desired goals and thus ensuring that the project will be delivered 
on time and within the budget.

Planning helps in identifying the total scope of project and the resources to perform the work. 
It helps to optimize the resources according to the project needs. It also helps to identify the 
risks, plan to minimize them, and then set priorities of the project according to the risk. It also 
helps to provide a baseline plan based on which the progress of the project is measured.

Planning Cycle
While constructing a building, the first step required is to lay foundation. Similarly, before 
building-up projects using the Project Management module, one has to start from the foundation 
to be laid in the construction of Enterprise Project Structure. Figure 1-1 shows the flow chart 
of project planning.

Figure 1-1  Flow chart of project planning

You can perform project planning using Primavera P6 module by following the steps given below:

•  Establish Goals: The first step of the planning process is to identify and establish goals. The 
next step is to get the detailed information of goals including the reasons for the selection and 
the anticipated outcomes of the projects. 
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•  Established Goals to be achieved by Organization: The Organizational Breakdown 
Structure (OBS) represents the hierarchical arrangement of the company management to fulfill 
the established needs. The OBS should be structured in such a way that each task in the Work 
Breakdown Structure (WBS) must be assigned to a person or committee. The OBS displays 
organizational relationships between the employees of an organization and according to that 
helps in assigning work resources in a project to the employees.

Each goal should have tasks or projects associated with its achievement. To achieve the goals, 
most useful and important structure for a project is the WBS. The WBS is continuation to 
the EPS for individual projects in an organization. WBS can be identified as breaking down 
complex projects into simpler, manageable, and interrelated tasks. A good work breakdown 
structure encourages a systematic planning process that covers all the key elements in a project 
and simplifies the project into manageable units. A WBS is used as a road map for planning, 
monitoring, and managing all the elements of a project such as scope of work, cost and time 
estimation, resource allocation and scheduling, productivity, and many more.

•  Identifying Resources: EPS is the hierarchical arrangements of the projects. It helps 
in managing multiple projects from higher to individual level and thereby facilitates the 
performance of specific tasks in an organization.   

• Prioritize Goals and Tasks: Prioritizing goals and tasks process is to arrange goals or tasks 
in terms of their importance. The most important tasks will be theoretically and practically 
approached and completed first. 

•  Goals Assigned to Resources: Each goal has some financial and human resource requirements 
associated with it. To achieve the goals, certain resources are required to be assigned. In Primavera 
P6, Resources Breakdown Structure (RBS) is an hierarchical structure of resources which are 
needed to accomplish the objectives of project. It is logical and useful classification of resources 
that can be used to optimize resource utilization. 

• Create Assignments and Baselines: As the projects are prioritized, it is required to establish 
baselines for completing associated tasks and assign resources to complete them. This portion 
of the management planning process should consider the abilities of the staff members and the 
time necessary to complete the assignments. 

• Tracking the Project’s Progress: A management planning process includes a strategy for 
evaluating the progress toward goal completion throughout an established time period. To 
evaluate the progress of a project, you need to keep a track of it.

CONTROLLING PROJECTS
Project control processes are performed to observe the project execution so that problems can 
be timely identified and corrective action can be taken, when necessary, to control the execution 
of the project. Project control includes measuring the ongoing project activities, monitoring 
the project variables such as cost, effort, scope and identifying the corrective actions to address 
risks and issues.
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MANAGING PROJECTS
Project management is done by the Project Manager responsible for accomplishing the stated 
project objectives. Project management includes development of the project plan, managing 
project stakeholders, managing communication, managing project team, managing project 
risk, managing project schedule, managing project budget, managing project conflicts, and 
managing project delivery. Project Management depends upon the industry type, size, maturity, 
and culture of the company.

STARTING PRIMAVERA P6
Planning is an integral part in managing a project. Primavera P6 is a planning software that 
makes this activity an easier task. To start with Primavera P6, choose Start > All Programs > 
Oracle - Primavera P6 > P6 Professional R8.4 (for Windows 7); the Primavera P6 R8.4 will 
open with the Login to Primavera P6 Professional R8.4 dialog box, as shown in Figure 1-2. 
By default, the login name is displayed in the Login Name edit box. To login to Primavera P6, 
enter password in the Password edit box and then choose the OK button. By default, the login 
name and password to enter into primavera is admin. 

Figure 1-2  The Login to Primavera P6 dialog box

A PMDB database is already created for Primavera to work in the specified database. Create 
your own database by using the Browse button from the Database edit box. When you choose 
this button, the Edit Database Connections dialog box will be displayed, as shown in Figure 1-3. 

Figure 1-3  The Edit Database Connections dialog box
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In this dialog box, select the required database from the Available Databases list box or continue 
working on the standalone primavera with predefined database. You can add more database to 
the Primavera. To do so, choose the Add button from the Command bar of the dialog box; the 
Database Configuration wizard with the Select or Create Alias page will be displayed. Enter 
the required values in the page and keep choosing the Next button until you create your own 
database. You are required to enter the public login information like username and password 
for the database that you have created. As you finish creating database, choose the Finish button 
in this wizard. After specifying the database, choose the OK button in the Login to Primavera 
P6 Professional R8.4 dialog box; the Primavera P6 user interface will be displayed, as shown 
in Figure 1-4.

Figure 1-4  The Primavera P6 interface with the Home window

USER INTERFACE SCREEN
The Primavera P6 interface with the Home window consists of Directory bar, menubar, 
Command bar, and Status bar, refer to Figure 1-4. You can hide and unhide these options using 
the toolbar. To hide any of the toolbars, choose View > Toolbars, refer to Figure 1-5 and then 
clear the check mark corresponding to the toolbar name that you want to hide in the Home 
screen. You can choose the Customize option from the cascading menu; the Customize dialog 
box will be displayed, as shown in Figure 1-6. In the Customize dialog box, select the check 
boxes corresponding to the toolbar that you want to display. You can clear the check box from 
the Customize dialog box to hide the options from the toolbar.
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Figure 1-5  Options to hide or unhide a toolbar 

Figure 1-6  The Customize dialog box 
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Directory Bar
The buttons of the Directory bar help in displaying the windows quickly. The buttons in the 
Directory bar are described next.

Buttons Description

Projects Projects tab displays the Project window to review the Enterprise Project 
Structure (EPS) and allows to work on individual project.

Resources Displays the Resources window. It helps to add and modify the 
organization resources.

Reports Displays the Reports window which helps to create, run, edit, and 
delete project reports globally. You can also export and import the 
project reports.

Tracking Displays the Tracking window which helps in monitoring the progress 
of projects.

WBS Displays the Work Breakdown Structure window. This window helps 
in creating the work breakdown of the created projects.

Activities Displays the Activities window in which you can create, edit, and modify 
the activities of an open project. 

Assignments Displays the Resources Assignments window to view all the resource 
assignments of opened projects. You can view, add, and delete the 
resources assigned to the activities.

WPs & Docs Displays the Work Products and Documents window which helps to 
maintain work products and document records of the opened projects.

Expenses Displays the Project Expenses window to work with all the expense 
items for the open project.

Thresholds Displays the Project Thresholds window to calculate the estimated 
threshold for each activity in an open project.

Issues Displays the Project Issues window which helps to add, edit, or delete 
project related issues.

Risks Displays the Project Risks window which helps to calculate risks for 
the project.

Menubar 
The menubar contains drop-down menus which are used to access functions like creating and 
opening project, setting user preferences, and so on. The menubar also helps to hide and unhide 
the toolbars. It also helps to access project activities, create WBS, EPS, OBS, and access the help 
file from the menubar. The menus available in the menubar are briefly described next.
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Menu Description

File It helps to open existing project or create new projects and also 
allows to print, import and export the project.

Edit It helps to cut, copy, and paste the project and also helps in setting 
the user preferences.

View It helps in the formatting of the projects.

Project It includes all the elements of project such as activities, resource 
assignments, and WBS. It helps in creating WBS or activities and 
also enables users to enter into project risks and thresholds.

Enterprise It helps in creating EPS, OBS, tracking projects, and arranging 
calendars.

Tools It helps to generate reports and monitor thresholds.

Admin It helps in the admin services.

Help It allows to access the help content of primavera.

Command Bar
The Command bar is displayed by default on the right side of the Primavera interface screen 
when a project is opened. The Command bar displays the command to add a new project or 
activity, delete an existing project or activity and so on.

Status Bar 
The Status bar is located at the bottom of the Project screen which describes the status of an 
opened project.

WORKSPACE
In the user interface, you can select any of the tabs to display the corresponding layout. The 
workspace of each window will display the menubar, Directory bar, Toolbar, Command bar 
and its detailed table. For example, if you choose the Activities tab from the Directory bar, the 
Activities window will be displayed, as shown in Figure 1-7. 
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Figure 1-7  The Activities window with the details of the window

The Details table in the window displays the details of the opened window. You can enter general 
information, status, summary, comments, and so on related to the corresponding window in 
the table.

SETTING USER PREFERENCES
In Primavera, you can set user preferences as required. For example, indicate the format for 
displaying time units and dates, specify the currency to be used for viewing costs, and set startup 
display preferences. To set the user preferences, choose the User Preferences option from the 
Edit menu; the User Preferences dialog box will be displayed. This User Preferences dialog 
box is divided into ten tabs: Time Units, Dates, Currency, Assistance, Application, Password, 
Resource Analysis, Calculations, and Startup Filters. The description of these tabs is given next.

Time Units Tab
The Time Units tab, as shown in Figure 1-8, allows you to define the time scale and to set the 
format that you want to use while displaying small and large-scale time units. It also allows to track 
layouts, set duration of activities, set resource prices, check availability, and display work efforts.

In the Units Format area, set the time unit in the Unit of Time drop-down list. If you want to 
include the next smallest time interval, select the Show Unit label check box. On doing so, 
the Sub-unit check box will be enabled. Select the Sub-unit check box to display the time with 
primary and secondary units. For example, if you select Hour in the Unit of Time drop-down list, 
the Sub-unit edit box will display Minutes. In the Decimals drop-down list, select the number 
of decimal places you want to include in the time unit value.
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Figure 1-8  The User Preferences dialog box with the Time Units tab displayed

In the Durations Format area, select an option for the unit from the Unit of Time drop-down 
list. To enable the Sub-unit edit box, select the Show Duration label check box. In the Decimals 
drop-down list, select the number of decimal places to display the activity duration value.

In the Units/Time Format area, select the Show as a percentage(50%) radio button to display 
the resources units/time as percentage. To display the resources units/time as a unit duration 
value, select the Show as units/duration radio button.

Dates Tab
In the Dates tab, as shown in Figure 1-9, you can change the date and time format as desired. 

In the Data Format area, select the radio button corresponding to the date format you want to 
use. Similarly, select the required radio button of the time format from the Time area. In the 
Time area, the Show minutes check box will be enabled only when you choose a radio button 
corresponding to time. Select the check boxes in the Options area to indicate how the selected 
date format should appear. In the Separator edit box of the Options area, select the character 
you want to use for distinguishing date, month, and year.
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Figure 1-9  The User Preferences dialog box with the Dates tab chosen

Currency Tab
The Currency tab, as shown in Figure 1-10, allows you to select a currency for viewing monetary 
values. To edit the monetary values, choose the Browse button from the Select a currency for 
viewing monetary values edit box; the Select Currency dialog box will be displayed. In the 
Select Currency dialog box, select the desired currency and choose the Select button;
the currency is assigned to the project and the Select Currency dialog box is closed and 
the User Preferences dialog box is displayed. The Show currency symbol and Show decimal 
digits check boxes are selected by default to display the currency symbol and decimal digit in 
the project.



1-14                                                                                     Exploring Oracle Primavera P6 R8.4
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 1-10  The User Preferences dialog box with the Currency tab chosen

Assistance Tab
The Assistance tab, refer to Figure 1-11, allows to use wizards instead of standard dialog boxes. 
Wizards guide you through necessary steps to complete a function. As you become comfortable 
in adding resources and activities, you can easily add them and do not need the directions. 
Select the check boxes in the Wizards area to display the New Resource Wizard for adding a 
new resource, and the New Activity Wizard wizard for adding a new activity in their respective 
windows.	
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Figure 1-11  The User Preferences dialog box with the Assistance tab chosen

Application Tab
The Application tab, refer to Figure 1-12, allows you to customize startup window, 
and also enables the user to trace the internal function to the log file. Also, in this tab 
you can set options for grouping and sorting of data. In the Columns area, you can specify the 
financial periods to be set in columns. In the Startup Window area, select the options from the 
window that you wish to display each time you start the module from the Application Startup 
Window drop-down list. Select the Show the Welcome dialog at startup check box to display 
the Welcome dialog box at the startup. Using the options available in the Welcome dialog box, 
you can create a new project, open an existing project, open the last project opened in your 
previous session, and display global data only.

In the Application Log File area, select the Write trace of internal functions to log file check 
box to record the actions in the log file.

In the Grouping and Sorting area, you can enable or disable the Show ID/Code or Show Name/
Description edit box by selecting or clearing the corresponding check boxes. In the Columns 
area, choose the Browse button to assign a range of financial periods to be viewed in columns. 
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Figure 1-12  The User Preferences dialog box with the Application tab chosen

Password Tab
The Password tab allows you to change the password of the current application. To change the 
password, choose the Password button; the Change Password dialog box will be displayed. In 
this dialog box, enter a new password and then confirm the password. Next, choose the OK 
button; the Primavera P6 Professional R8.4 message box will be displayed informing you that 
password has been changed successfully. 

Resource Analysis Tab
The Resource Analysis tab, refer to Figure 1-13, allows you to specify the resources to be shown 
in the resource usage spreadsheet. Also in this tab, you can specify the date and time interval to 
be used to calculate time-distributed data for resource spreadsheets and profiles.
 



Getting Started with Primavera P6	                                                           1-17

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 1-13  The User Preferences dialog box with the Resource Analysis tab chosen

In the All Projects area, you can select any one of the radio buttons to define the projects you 
want to display in the resources usage profile and spreadsheet. In the Time-Distributed Data 
area, select a starting point for calculating remaining units and costs to be displayed in  the 
Resource Usage Profiles, the Resource Usage Spreadsheet, tracking layouts, and Primavera Web 
application charts. To show the remaining values, select the Remaining Early dates radio button 
to calculate values based on remaining start/finish dates. To show remaining values, select the 
Forecast dates radio button to calculate values based on forecasted start/finish dates.

Next, select an interval from the Interval for time-distributed resource calculations drop-down 
list at which the live resource and cost calculations are performed for Resource Usage Profiles 
and Resource Usage Spreadsheet.

Calculations Tab
The Calculations tab, refer to Figure 1-14, allows you to allocate cost and units on adding and 
deleting multiple project resources. It also enables you to specify how to calculate remaining 
values when new resource assignments are added or removed from activities. You can also choose 
the default behavior when replacing a resource/role on an existing activity assignment with a 
different resource/role.
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Figure 1-14  The User Preferences dialog box with the Calculations tab chosen

In the Resource Assignments area, select the Preserve the Units, Duration, and Units/Time for 
existing assignments radio button for units, duration and units/time to remain constant even 
if new resource assignments are added to existing projects. To recalculate the units, duration 
and units/time for existing assignments or for newly added assignments, you need to select the 
Recalculate the Units, Duration, and Units/Time for existing assignments based on the activity 
Duration Type radio button. While replacing a resource on an existing activity assignment, you 
need to use the units/time and overtime factor of the new resource. While assigning a resource 
to an existing role, you need to use the price/unit of the resource or role.

Startup Filters Tab
The Startup Filters tab contains the default filters to start the Primavera P6 application. You 
can choose this tab to view the data related to current projects or all the data in the database. 
These filters can reduce the time taken in opening projects.
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SETTING ADMIN PREFERENCES
The admin preference settings established by the project controller are required to make specific 
changes in a project. To specify the admin settings, select the Admin Preferences option from 
the Admin menu; the Admin Preferences dialog box will be displayed, refer to Figure 1-15. 
This dialog box consists of nine tabs: General, Data Limits, ID Lengths, Time Periods, Earned 
Value, Reports, Options, Rate Types, and Industry.

Figure 1-15   The Admin Preferences dialog box with the General tab chosen

General Tab
In the General tab, you can specify general options, such as the weekday from which the calendar 
week begins. You can change the character used to separate hierarchy levels in resource, project, 
activity codes, roles, cost accounts, and WBS elements. You can also change the default duration of 
activities. You can change the password policy by selecting the Enable password policy check box.

Data Limits Tab
The Data Limits tab enables you to specify the maximum number of levels for hierarchical 
structures. You can also specify the maximum number of baselines and activity codes that can 
be included in a project.
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ID Lengths Tab
The ID Lengths tab enables you to set the number of characters to be displayed as ID or Code 
such as Project ID, WBS Code, Resource ID, Activity ID, Cost Account ID, and so on at each 
tree level.

Time Periods Tab
In the Time Periods tab, you can set the number of work hours such as Hours/Day, Hours/Week, 
Hours/Month, or Hours/Year. You can also specify abbreviations for displaying minutes,
hours, days, weeks, months, and years.

Earned Value Tab
In the Earned Value tab, you can change the default earned value settings. You can also change 
the settings for computing the techniques of budget estimation. 

Reports Tab
In the Reports tab, you can make settings for the display of reports. Using this tab, you can 
define the sets to display the reports. It can be displayed in first set, second set, and third set 
with the header, footer, and custom label for reports.

Options Tab
In the Options tab, you can specify the time interval during which cost and quantity 
summaries can be calculated for Resource Usage Spreadsheet and Activity Usage 
Spreadsheet. 

To access Contract Management, select the Enable Link to Contract Management check box, 
and then type the URL and port number in the Contract Management web server. Once the 
access to Contract Management is established with the required privilege, you can then link 
your project to a Contract Management project to enable users to import and view Contract 
Management project information.

If you attempt to link P6 Professional to Contract Management via an HTTPS:// URL, and the 
SSL library is not loaded, you will get an error message.

When you select the Online Help option from the Help menu, the URL that is specified in this 
section will be launched. If the P6 Professional Online Help URL field is blank, the Online 
Help option in the Help menu is disabled for all users.

Rate Types Tab
The Rate Types tab enables you to specify the resources and roles rate types.

Industry Tab
This tab allows you to choose the type of industry in which you want to use the application. To 
select an industry for the project, select the radio button correspondig to the required options.
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CREATING A NEW PROJECT
A project can be defined as a set of planned interrelated tasks to be executed over a fixed period 
of time and within certain cost and limitations. In Primavera P6, there are existing sample 
projects that can be used as a reference or you can create your own project.
 
WBS is defined as Work Breakdown Structure which is a hierarchical arrangement of deliverables 
produced during or by a project. WBS allows you to divide a project into meaningful and logical 
pieces for the purpose of planning and control.  

The projects are created under EPS (Enterprise Project Structure). To create a new project, choose 
the New option from the File menu; the Create a New Project wizard will be displayed. In this 
dialog box, choose the Browse button corresponding to the Select EPS edit box and select the 
EPS under which you want to create the project. 

OPENING A PROJECT
You can open a project by choosing the Open option from the File menu. When you choose this 
option, the Open Project dialog box will be displayed, refer to Figure 1-16. In this dialog box, 
expand the projects node to view the complete project. From the displayed list, select a project 
and then choose the Open button to open the existing project. 

Figure 1-16  The Open Project dialog box
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EXPORTING A PROJECT
You can export a project and save it for further use. To export a project, choose the Export option 
available in the File menu; the Export wizard with the Export Format page will be displayed, 
as shown in Figure 1-17. 

Figure 1-17  The Export wizard with the Export Format page 

In this dialog box, select the required radio button to set the format in which you want to export 
the file. Then, choose the Next button; the Export Type page will be displayed, as shown in 
Figure 1-18. 

Figure 1-18  The Export wizard with the Export Type page 
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In this page, select the type of data that you want to export by selecting the Project, Resource 
Only, or Role Only radio button. On selecting the Project radio button, the complete project 
will be exported. The Resource Only radio button allows you to export the resources of the open 
project. You can select the Role Only radio button to export the roles of the opened project. Now, 
choose the Next button; the Projects To Export page will be displayed, as shown in Figure 1-19.

Figure 1-19  The Export wizard with the Projects To Export page 

In this page, you can view the opened projects that are to be exported as a file. Choose the Next 
button; the File Name page will be displayed, as shown in Figure 1-20. In this page, you can 
choose the Browse button corresponding to the File Name edit box. 

Figure 1-20  The Export wizard with the File Name page 
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On doing so, the Save File dialog box will be displayed, as shown in Figure 1-21. In this dialog 
box, browse to the folder where you want to save the opened file and then choose the OK button; 
the Save File dialog box will be closed. Now, choose the Finish button, the export process 
will start and then the Primavera P6 message box will be displayed, as shown in Figure 1-22, 
informing that the export was successful. Choose the OK button; the file will be exported and 
the export dialog box will be closed.

Figure 1-21  The Save File dialog box 

Figure 1-22  The Export wizard with the Export Results page
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IMPORTING A PROJECT
To save time, you can import primavera files to the module. To import a project, Enterprise 
Project Structure (EPS) should be in the Projects window under which the project will be imported. 
Now, select the Import option from the File menu; the Import wizard with the Import Format 
page will be displayed, as shown in Figure 1-23.

 

Figure 1-23  The Import wizard with the Import Format page 

In this dialog box, select the desired radio button for the file format that you want to import. 
Now, choose the Next button; the Import Type page will be displayed, as shown in Figure 1-24. 

Figure 1-24  The Import wizard with the Import Type page
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In this page, select the radio button corresponding to the type of data you want to import in a 
project. The data types can be a project, resource or role only. After making the selection, choose 
the Next button; the File Name page will be displayed. In this page, browse to the .xer format 
file by choosing the Browse button corresponding to the File Name edit box; the Select Import 
File dialog box will be displayed. In this dialog box, browse to the location where the file is saved 
and then choose the Open button; the path of the file will be displayed in the File Name edit 
box. Choose the Next button; the Import Project Options page will be displayed, as shown in 
Figure 1-25. The options in this page will allow you to find the project that is to be imported. 

Figure 1-25  The Import wizard with the Import Project Options  
page

Choose the Browse button under the Import To column; the Select Project dialog box will be 
displayed. In this dialog box, select the project that you want to import and then choose the 
Select button; the selected project will be assigned under the Import To column. Now, choose 
the Next button; the Update Project Options page will be displayed, as shown in Figure 1-26. 

In this page, you can add, modify, or remove the layout that is created in a project. To add a 
new layout, choose the Add button to make changes in the layout and name it accordingly. Once 
the modifications are done, choose the Next button; the Finish page will be displayed with the 
message that you are ready to import the file, as shown in Figure 1-27. Choose the Finish button; 
the import process will start and the Primavera P6 message box will be displayed informing 
you that the import was successful. Choose the OK button; the Primavera P6 message box will 
be closed and the project will be imported. 



Getting Started with Primavera P6	                                                           1-27

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Figure 1-26  The Import wizard with the Update Project 
Options page

Figure 1-27  The Import dialog box with the Finish page
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Self Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 In which of the following menus, the User Defined Fields option appears?
	
		  (a)  File					    (b)  Edit
		  (c)  Enterprise 				    (d)  Tool

2.	 Which of the following tabs is used to modify the currency in a project?

		  (a)  Currency 				    (b)  Assistance
		  (c)  Resource Analysis			   (d)  Calculations

3.	 The ___________ tab is used to display the default application startup window.

4.	 The ___________ window is used to calculate the threshold in a project.

5.	 The ___________ tab is used to set the date format.

6.	 You can create your own database in Primavera P6 module. (T/F)

7.	 You cannot toggle on/off the display of toolbars. (T/F)

8.	 The Time Units tab enables you to change unit of time. (T/F)

9.	 In Primavera P6, you can access to either network such as MAPI or SMTP.  ( T/F )

10.	 You cannot control the display of wizards on adding new activities and resources. (T/F)

Review Questions
Answer the following questions:

1.	 Which of the following options allow you to import a file?

		  (a) Export				    (b) Page Setup
		  (c) Send Project				   (d) Import
	 	
2.	 Which of the following duration types is used in a project?

		  (a)  Fixed Unit				    (b)  Fixed Duration and Units/Time
		  (c)  Fixed Units/Time			   (d)  Fixed Duration & Units
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3.	 Which of the following softwares is used to generate the project schedule?

		  (a)  Microsoft Excel			   (b)  Microsoft Project
		  (c)  Primavera				    (d)  All of the above

4.	 Which of the following is full form of MAPI ?

		  (a)  Messaging Application Internet	 (b)  Messaging Applicant Investigation
		  (c)  Mail Application Internet		  (d)  Messaging Application Interfcae

5.	 Which of the following tabs helps in displaying the issues in a project?	

		  (a)  Risks				    (b)  Thresholds
		  (c)  Issues				    (d)  Expenses

6.	 Which of the following bars is displayed on initial interface screen?

		  (a)  Navigation Bar			   (b)  Directory bar
		  (c)  Status bar				    (d) All of the above

7.	 You can create a PMDB database in Primavera P6. (T/F)

8.	 You can open an existing project using the Open option from the File tab. (T/F)

9.	 You can create a new project using the Open option from the File menu. (T/F)

10.	 The Issue Navigator dialog box is used for outstanding issues that are generated based on 
the preset thresholds. (T/F)
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Answer to Self Evaluation Test
1. c, 2. a, 3. Application, 4. Threshold, 5. Dates, 6. T, 7. T, 8. T, 9. T, 10. F


